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DreamWeaver Practice Test 1
True/False
Indicate whether the statement is true or false.
____

1. Code view is the best view for debugging or correcting errors.

____

2. You can use the Property inspector to format text so that it is attractive and easy to read.

____

3. A page with too many graphical elements might take a long time to load, which could cause visitors to leave
your website.

____

4. To ensure that all links are current and work correctly, you need to test them regularly.

____

5. The head content of a web page contains only page content that is visible in the browser.

____

6. When adding keywords, you should not worry about the order in which they are listed.

____

7. Using fonts within the default settings is wise, as fonts set outside the default settings may not be available on
all computers.

____

8. You can drag the slider on the left side of the History panel to undo or redo steps.

____

9. You should build web pages with large amounts of text, instead of dividing the content in multiple pages, as
this makes it easier for viewers to digest it all.

____ 10. You should use paragraph indentations to create an unordered list.
____ 11. Embedded style sheets are created automatically by Dreamweaver if the designer does not create them.
____ 12. Sans-serif fonts are block-style characters that are often used for headings and subheadings.
____ 13. If you delete a file on the Files panel that has an active link to it, you will receive a warning message.
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____ 14. The image above is a portion of the Image Preview dialog box.
____ 15. Links that connect the pages within a website are always very important because they help viewers navigate
between the pages of the site.
____ 16. A good website often includes a variety of external links to other related websites so that viewers can get
more information on a particular topic.
____ 17. Each page in a website usually focuses on multiple categories or topics.
____ 18. Meta tags act as targets for internal links and make it easy for viewers to jump to a particular place on the
same page quickly.
____ 19. Because the World Wide web changes constantly, websites may be up one day and down the next.
____ 20. A table placed inside another table is called a double table.
____ 21. Dreamweaver CS5 allows you to set up multiple servers.
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____ 22. It is very hard to locate compelling and media-rich content for websites on the Internet.
____ 23. Websites have rules that govern how a user may use its text and media, known as derivative works.
____ 24. A site’s terms of use override your right to apply fair use.

____ 25. The figure above shows the remote server settings in the Add/Remove Server dialog box.
Multiple Choice
Identify the choice that best completes the statement or answers the question.
____ 26. A ____ is a group of related webpages that are linked together and share a common interface and design.
a. web browser
b. web tool
c. web code
d. website
____ 27. The ____ toolbar contains buttons that are used when working directly in the code.
a. Document
b. Standard
c. Style Rendering
d. Coding
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____ 28. A ____ is a particular way of displaying page content.
a. panel
b. home page
c. navigation structure
d. view
____ 29. ____ view shows the page as it would appear in a browser and is primarily used for designing and creating a
webpage.
a. Code and Design
b. Code
c. Debugging
d. Design

____ 30. Item ____ above is the Browse for File icon.
a. 4
b. 5
c. 6
d. 7
____ 31. If you do not want the Dreamweaver Welcome Screen to appear each time you start Dreamweaver, click the
____ check box on the Welcome Screen.
a. Collapse all icons
b. Don’t show again
c. Don’t show view
d. Collapse all panels

____ 32. In the figure above, which number points to the select tool?
a. 3
c. 5
b. 4
d. 6
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Case Based Critical Thinking
Case 1
You are in the planning stages of designing a website to market children’s books. The continually expanding
field of children's books makes this an exciting adventure. Answer the following two questions about
planning the site.
____ 33. Who is the target audience?
a. Babies
b. Teenagers
c. Parents
d. The publishing company
Case 2
You have been asked to lead a small group of employees tasked with creating a strong website for the XYZ
Corporation. Everyone in the group is familiar with Dreamweaver, but as always, questions arise as you all
work together to complete the site.
____ 34. What process would best ensure that the site contains accurate information, looks good, and works smoothly?
a. Create pages, set up the basic structure, plan the site, publish the site
b. Publish the site, create pages, test pages, modify pages
c. Create pages, plan the site, modify pages, publish the site
d. Plan the site, set up the basic structure, create pages, test pages, modify pages, publish the
site
____ 35. The ____ content of a web page contains information used by search engines to help viewers find your
website.
a. body
b. html
c. head
d. meta data
____ 36. The ____ of a web page includes the page title that appears in the title bar of the browser and some important
page elements that are not visible in the browser.
a. meta tags
b. keywords
c. head content
d. body
____ 37. ____ is a rating system for web pages that is similar to rating systems used for movies.
a. Meta tags
b. MDI
c. PICT
d. POWDER
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____ 38. Dreamweaver’s web-safe color palettes contain ____ web-safe colors.
a. 64
b. 128
c. 216
d. 256
____ 39. The ____ color is the color that fills the entire web page.
a. main
b. fill
c. foreground
d. background

____ 40. Item ____ in the figure above indicates web-safe palettes.
a. 1
b. 2
c. 5
d. 6
____ 41. A font ____ is a set of three fonts that specify which fonts a browser should use to display the text of your
web page.
a. combination
b. set
c. list
d. arrangement
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Case Based Critical Thinking
Case 1
Tayler works in the Marketing Department for BusyBody Toymakers. She is working with a team to develop
a website showcasing this year’s most popular toys. As the team discusses colors for the site, Tayler mentions
that the people viewing the site may be using different types of computers. Although the issue has become
less important today with most computers capable of displaying millions of colors, the team keeps Tayler’s
suggestions in mind as they develop the site.
____ 42. If the design team wants the web pages to be viewed across a wide variety of computer platforms, they should
choose ____ for all page elements.
a. only two basic colors
b. different color palettes
c. web-safe colors
d. capable colors
____ 43. Dreamweaver’s default color palette is Color Cubes. One of Tayler’s team members would like to choose a
different color palette. Tayler shows the team that the color palettes are located ____.
a. on the Menu bar
b. in the Appearance category
c. in the Page Properties
d. in the Color Picker
____ 44. If you position an insertion point in text that has a CSS rule applied to it, where is that rule displayed on your
screen?
a. Class text box in the HTML Property inspector
b. Targeted Rule text box in the HTML Property inspector
c. Targeted Rule text box in the CSS Property inspector
d. Both a and c
____ 45. What is the term for CSS that are part of an HTML file?
a. External style sheets
b. Internal style sheets
c. Connected CSS
d. Joined style sheets
____ 46. Use the shortcut [Ctrl][`] to ____.
a. Refresh
b. Browse in Bridge
c. Switch views
d. Indent text
____ 47. Use the [F5] shortcut to ____.
a. Switch views
b. Browse in Bridge
c. Refresh
d. Insert image
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____ 48. Which of the following statements about lists is false?
a. Items in unordered lists are usually preceded by a bullet.
b. Unordered lists are lists of items that are presented in a specific sequence.
c. Ordered lists are sometimes called numbered lists.
d. Unordered lists that contain bullets are sometimes called bulleted lists.
Case Based Critical Thinking
Case 1
Rae is building a website for the local chamber of commerce. This week, Rae is designing and completing a
page that contains a list, headings, body text, images, and a background. During this process, Rae develops a
style sheet for the project.
____ 49. Rae decides to add a rule to a Cascading Style Sheet. Rae should click the ____ in the CSS Styles panel.
a. New CSS Rule button
b. Edit Style button
c. Style list arrow
d. New Style button
Case 2
Carolyn is a web designer who is responsible for the home page for a real estate company with branches in all
50 states. The home page should be attractive and functional, allowing potential sellers and buyers to find
information quickly.
____ 50. Carolyn wants to be sure that the site can be viewed on various handheld devices. Which of the following
will help her the most?
a. Tools menu
b. Toggle Display button
c. Style Rendering toolbar
d. Application bar
____ 51. The code Carolyn has written for the site is getting very long and complex. What can she do to display the
code in a more condensed way?
a. She can collapse sections of code using tools found in the tools menu.
b. She can collapse sections of code using the Collapse Selection buttons on the Coding
toolbar.
c. She can use the Simplify Code button on the Coding toolbar.
d. She can recode longer sections using the Code Simple toolbar.
____ 52. Which of the following is not a graphic file format?
a. PNG
b. JPEG
c. GIF
d. TIGG
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____ 53. How many category buttons can be found in the Assets panel?
a. six
b. ten
c. eight
d. nine
____ 54. Which of the following is the power user shortcut for Refresh?
a. [Ctrl][R]
b. [F5]
c. [F3]
d. [Option][F]

____ 55. In the figure above, what is the name of item 3?
a. Format list arrow
b. Preview Format list arrow
c. Format Menu list arrow
d. Format options
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____ 56. In the figure above, the number 1 is pointing to the ____.
a. Colors button
c. Image File button
b. Images button
d. Websafe Color button
Case Based Critical Thinking
Case 1
As the designer for an online catalog, Rob is extremely familiar with the various ways he can add photos and
other graphics to websites. He just hired Beth to be his assistant, and while she is very good with the
planning process, she lacks some skills when it comes to actually putting the pieces of the catalog together
using Dreamweaver. Always patient, Rob has decided to take Beth under his wing and teach her what he
knows.
____ 57. Beth wasn’t very clear on the various types of graphic file formats used when creating the catalog. Which of
the following formats does Rob tell her they will use, and why?
a. PNG, because it is supported by the most current browsers
b. TIFF, because although it is limited in the number of colors it can represent, it shows
transparent areas well
c. JPEG, because it can display so many colors and will give an accurate picture of the
products in the catalog
d. GIF, because it is the fastest to upload

10

Name: ________________________

ID: A

____ 58. The figure above illustrates a(n) ____ path.
a. absolute
b. relative
c. root-relative
d. document-relative
____ 59. You should design the navigation structure of your website so that viewers are never more than ____ clicks
away from the page they are seeking.
a. one or two
b. two or three
c. three or four
d. four or five
____ 60. How do you insert a Spry menu bar?
a. Click Insert on the Tools Menu bar, then click Spry Menu Bar.
b. Choose Spry Menu Bar from the Tools dropdown menu.
c. Click Insert on the Application bar, point to Layout Objects, then click Spry Menu Bar.
d. Click Insert on the Layout Application bar, point to Menu, then click Spry Menu.

____ 61. In the figure above, the three links in the Assets panel are ____ links.
a. external
b. internal
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____ 62. When choosing an option in the Target list of an image map, __top displays ____.
a. the destination page in a separate browser window
b. the destination page in the whole browser window
c. the destination page in the same frame or window
d. the destination page in the parent frameset
____ 63. The shortcut to Check Links Sitewide in Windows is ____.
a. [Ctrl][W]
b. [Ctrl][F8]
c. [F5]
d. [Shift][F8]
____ 64. Which of the following statements about placeholder text is false?
a. Before deleting placeholder text, it is a good idea to read it.
b. Placeholder text can help you to understand the way a page is designed.
c. Placeholder text can give you pointers for the best way to place the actual text.
d. Placeholder text can give you an idea of what your final text should actually say.

12

Name: ________________________

ID: A

____ 65. In the figure above, which number points to the styles for a predesigned CSS layout?
a. 1
b. 2
c. 3
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____ 66. In the figure above, where can you see the cell tag?
a. Below the Properties panel
b. Directly above the Properties panel
c. At the top of each column
d. None of the above
Case Based Critical Thinking
Case 1
Ben is in charge of creating a new website for Cooing Kids Pacifiers, and he is planning to use predesigned
CSS layouts. This is his first time using CSS page layouts, so he asks his friend, Jann, for some pointers.
____ 67. Which of the following is a good reason that Ben decided to use predesigned layouts?
a. They use div tags to control the placement of page content.
b. Each div tag container has placeholder text that appears until it is replaced.
c. He should be able to find a layout he likes among the 18 available styles.
d. He can be sure that his pages will appear with a consistent design on all browsers.
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____ 68. Before you publish a site you should verify that all pages have titles, and remove all ____ colors.
a. CMYK
b. RGB
c. Websafe
d. Non-websafe
____ 69. Files that you have checked in are marked with ____ icons in the Files panel.
a. stop sign
b. key
c. padlock
d. “do not”
____ 70. If you are not concerned with replacing outdated image files, you should cloak the ____ folder of a website to
save time when synchronizing files.
a. root
b. parent
c. child
d. assets
____ 71. In Windows, you can cloak a folder by ____ the folder, pointing to Cloaking, and then clicking Cloak.
a. left-clicking
b. right-clicking
c. [Ctrl]-clicking
d. [Shift]-clicking
____ 72. To export the site definition file to another location, you should open the ____ dialog box.
a. Manage Sites
b. Export Sites
c. Site Definitions
d. Site Options
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____ 73. The red arrow in the figure above points to ____.
a. the Notes icon for the activities file
b. Date icon for the activities file
c. a checked out file
d. a dependent file
____ 74. The ____ web server is a public domain, open source web server that is available using several different
operating systems including UNIX and Windows.
a. VSS
b. WebDav
c. Apache
d. RDS
Case 2
Brandon works for a large construction firm in the Northeast. Brandon was hired for his excellent skills in
web design, specifically his experience with Dreamweaver. Brandon is eager to put his experience and skills
to good use.
____ 75. Brandon understands that the site definition for a website contains critical information about the site,
including password information that he wants to keep secret from other site users. You recommend saving
the site definition file ____.
a. in the website
b. in an external folder
c. in an internal file
d. on a web page
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Completion
Complete each statement.
76. XHTML is the acronym for ______________________________.
77. HTML stands for _________________________.
78. The ____________________ structure is the way viewers navigate from page to page in your website.
79. The Coding toolbar is available only in Code view and appears on the ____________________ side of the
Document window.
80. Directly below the Application bar is the ____________________ toolbar.
81. The Property inspector is ____________________, which means it changes according to what is selected in
the Document window.
82. Panels can be opened using the Window menu commands or the corresponding ____________________.
83. The view buttons are located on the ____________________ toolbar.
84. The ____________________ folder stores all of the files for your site.
85. Modifying and ____________________ pages in a website is an ongoing process.
86. URL stands for ____________________.
87. A(n) ____________________ is a web server that hosts websites and is not directly connected to the
computer housing the local site.
88. When docking a panel group, the ____________________ is a heavy blue line that appears when the panel is
in the correct position to be docked.

89. In the figure above, the number 4 points to the ____________________.
90. In the figure above, the number 5 points to the ____________________.
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91. In the figure above, the number 6 points to the ____________________.
92. ____________________ is area on a web page that contains no text or graphics.
93. Viewers of a website should always be able to easily find their way back to the ____________________
page.
94. POWDER is the acronym for ____________________.
95. Links pointing outside of the website are called ____________________ links.
96. ____________________ are sets of formatting attributes that can be used to format web pages and provide a
consistent presentation for content across the site.
97. ____________________ links are links that cannot find their intended destinations.
98. A common point of contact is a(n) ____________________ link, which is an e-mail address that viewers with
questions or problems can use to contact someone at the company’s headquarters.
99. A(n) ____________________ is an area on a web page that contains links to the main pages of a website.
100. You can create comments in any Dreamweaver view, but you must turn on ____________________ to see
them in Design view.

101. In the figure above, the number ____________________ points to the title icon.
102. Unordered lists that contain bullets are sometimes called ____________________ lists.
103. CSS style sheets contain styles, or ____________________, which define the formatting attributes for page
content.
104. You can click the Edit Rule button in the CSS Styles panel to open the CSS ____________________.
105. Arial and Helvetica are ____________________ fonts.
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106. The ____________________ toolbar has buttons that expand or collapse code, buttons that change the way
code is displayed, and buttons for inserting and removing comments.
107. Some people consider ____________________ fonts easier to read in printed material, because the extra
strokes lead your eye from one character to the next.
108. ____________________, or GIF, is a common graphic file format.
109. When you add a graphic to a website, Dreamweaver automatically adds it to the ____________________
panel.
110. You can use the Assets panel to add an asset to a web page by dragging the asset from the Assets panel to the
page or by using the ____________________ button on the Assets panel.
111. Positioning an image can also be called ____________________ an image.
112. Your can organize the assets in the Assets panel by using the Site and ____________________ options
buttons.
113. ____________________ are frames that appear around an image.
114. You can copy a Photoshop PSD file and paste it directly into Dreamweaver. After inserting the image,
Dreamweaver will prompt you to ____________________ the image for the web.
115. One of the easiest ways to make your web page viewer-friendly and accessible to people of all abilities is to
use ____________________.
116. In addition to being able to save an image using different file formats on the ____________________ tab,
you can also use the File tab to scale or resize an image.
117. In most browsers today, when you add a web page to your favorites list or bookmarks, the page title will
appear with a small icon that represents your site, similar to a logo, called a ____________________.
118. On most websites, viewers are able to save an image on a page by right-clicking an image, then clicking Save
on the ____________________ menu.
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119. In the figure above, the number ____________________ points to the list of images in the website.

120. The figure above is the ____________________ dialog box.
121. The first part of a link is the element that viewers see and click on a web page, for example, text, an image, or
a(n) ____________________.
122. The second part of a link is the ____________________, or the name and location of the web page or file that
will open when the element is clicked.
123. URL stands for _________________________.
124. To make it easier for viewers to navigate to specific areas of a page without scrolling, you can use a
combination of internal links and ____________________.
125. A(n) ____________________ is the location on a web page that a browser displays when an internal link is
clicked.
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126. With respect to navigation bars, a(n) ____________________ is the condition of the element relative to the
mouse pointer.
127. A(n) ____________________ link , like a misspelled word on a web page, indicates that a website is not
being maintained diligently.
128. To adjust the shape of a hotspot, click the ____________________ tool in the Property inspector, then drag a
sizing handle on the hotspot.
129. ____________________ consist of containers formatted with CSS styles into which you place web page
content.
130. Tables are placeholders made up of small boxes called ____________________.
131. The ____________________ feature flags code that might present a CSS rendering issue in some browsers
by underlining code in green.
132. Dreamweaver CS5 provides 16 predesigned layouts that are available in the ____________________ dialog
box.
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133. In the figure above, the number ____________________ points to the styles for an external style sheet.
134. In the figure above, the number ____________________ points to the styles for predefined CSS layout.
135. You can change the border color of div tags when the mouse is positioned over them in the
____________________ dialog box.
136. ____________________ Tables mode adds extra space between cells, which makes it easier to select small
cells.
137. WYSIWYG is the acronym for ____________________, and means that your page should look the same in
the browser as it does in the web editor.
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138. In the figure above, the number ____________________ points to the click list arrow used to choose pixels
or percent.
139. To ____________________ cells means to combine multiple cells into one cell.
140.

To reset columns and rows to their previous widths and heights, select the table, click Modify on the
Application bar (Win) or Menu bar (Mac), point to Table, then click ____________________ Cell Heights or
____________________ Cell Widths.

141. Once you have created all the pages of your website, finalized all the content, and performed site maintenance
to ensure that all links work properly, all colors are websafe, and all orphaned files are removed, you are
ready to ____________________ your site to a remote server so the rest of the world can access it.
142. Before you publish your website, you should view the pages in at least ____________________ different
browsers and different versions of the same browser to ensure that everything works correctly.
143. The most common Access setting is FTP, which stands for _________________________.
144. After you finish editing a checked-out file, you will need to save and close the file, then click the
____________________ button to check the file back in and make it available to other users.
145. ____________________ a file marks it for exclusion from several commands, including Put, Get,
Synchronize, Check In, and Check Out.
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146. The site definition for a website contains important information about the site, including its URL, preferences
that you’ve specified, and other secure information such as the ____________________ and password
information.
147. In Dreamweaver, you can use the ____________________ command to export the site definition file to
another location.
148. A(n) ____________________ is the permission given by a copyright holder that conveys the right to use the
copyright holder’s work under certain conditions.
149. The familiar © symbol or “Copyright” is not required to indicate copyright, nor does it automatically
____________________ your work.
150. The web materials you incorporate into your own writings must be cited properly; this expectation applies
just as certainly to ideas you summarize or ____________________ as to words you quote verbatim.
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